
KODAK ESP 3200 Series
All-in-One Printer

Includes Information for the:

ESP 3250 All-in-One Printer

ESP 3260 All-in-One Printer

Extended User Guide

MS     SD/HC     MMC

Back Home



Eastman Kodak Company
Rochester, NY 14650
© Eastman Kodak Company, 2009
Kodak, EasyShare, and Perfect Touch are trademarks of Eastman Kodak Company.
Specifications subject to change without notice.
P/N 1K5832
September 2009



Table of contents

1  Printer Overview

Components.......................................................................................................................................................................1
Control panel.....................................................................................................................................................................2
Home Center Software ..................................................................................................................................................3

Home Center Software for WINDOWS OS-based computers .....................................................................3
Home Center Software for MACINTOSH Computers ....................................................................................3

2  Configuring Your Printer
Configuring printer settings ..........................................................................................................................................4

Configuring basic printer settings .........................................................................................................................4
Setting your printer as the default printer...........................................................................................................5

Connecting to another KODAK All-in-One Printer.................................................................................................5

3  Handling Paper
Paper types........................................................................................................................................................................7
Paper sizes.........................................................................................................................................................................7
Envelope sizes...................................................................................................................................................................8
Loading paper ...................................................................................................................................................................8

Loading plain paper...................................................................................................................................................8
Loading photo paper ................................................................................................................................................9
Loading envelopes................................................................................................................................................... 10

4  Printing Pictures
Changing Print Photos Options / Defaults .............................................................................................................. 11
Printing pictures from a memory card ..................................................................................................................... 12

Types of memory cards ......................................................................................................................................... 12
Printing a picture using the default settings ..................................................................................................... 12
Printing pictures using non-default photo options ......................................................................................... 13
Printing tagged pictures......................................................................................................................................... 14
Printing panoramic pictures.................................................................................................................................. 15

Transferring pictures to a computer......................................................................................................................... 15
Transferring pictures to a WINDOWS OS-based computer ....................................................................... 15
Transferring pictures to a MACINTOSH Computer ...................................................................................... 15

5  Copying
Making a copy................................................................................................................................................................. 16
Changing copy options................................................................................................................................................. 16

Changing copy document options ...................................................................................................................... 16
Changing copy photo options .............................................................................................................................. 18

Adjusting copy settings................................................................................................................................................ 19
Enlarging or reducing a document ...................................................................................................................... 19
Enlarging or reducing a photo .............................................................................................................................. 19
Darkening or lightening copies ........................................................................................................................... 20
www.kodak.com/go/aiosupport  iii



Table of contents
6  Scanning
Before you begin scanning ...........................................................................................................................................21
Simple scanning ..............................................................................................................................................................21
Scanning multiple pictures simultaneously ............................................................................................................22

Scanning multiple pictures with a WINDOWS OS-based computer ........................................................22
Scanning multiple pictures with a MACINTOSH Computer .......................................................................22

7  Maintaining Your Printer
General care and cleaning...........................................................................................................................................23

Cleaning the scanner glass .................................................................................................................................. 24
Cleaning inside the scanner lid ............................................................................................................................25

Replacing ink cartridges...............................................................................................................................................26
Replacing the printhead ...............................................................................................................................................29
Upgrading the printer software and firmware .......................................................................................................33

Upgrading software and firmware on a WINDOWS OS-based computer ..............................................33
Upgrading software and firmware on a MACINTOSH Computer .............................................................33

Monitoring and adjusting printer performance .................................................................................................... 34
Checking ink levels................................................................................................................................................. 34
Resetting factory defaults .................................................................................................................................... 34

8  Troubleshooting
Basic troubleshooting ...................................................................................................................................................35
Status light.......................................................................................................................................................................36

Power status light....................................................................................................................................................36

9  Product and Safety Specifications
Specifications and features .........................................................................................................................................37

Print performance ...................................................................................................................................................37
Photo printing features ..........................................................................................................................................37
Copy document features .......................................................................................................................................38
Copy photo features ...............................................................................................................................................38
Scanning features ....................................................................................................................................................38
Paper tray features..................................................................................................................................................39
Ink cartridges............................................................................................................................................................39
Connectivity..............................................................................................................................................................39
Software support .....................................................................................................................................................39
Physical specifications .......................................................................................................................................... 40
Warranty .................................................................................................................................................................. 40
System requirements ............................................................................................................................................ 40
iv www.kodak.com/go/aiosupport



KODAK ESP 3200 Series All-in-One Printer
Safety information ........................................................................................................................................................ 42
Regulatory compliance................................................................................................................................................44

FCC statement ........................................................................................................................................................44
Canadian statements.............................................................................................................................................44
German compliance statement .......................................................................................................................... 45
REACH Article 33 declarations........................................................................................................................... 45
Waste electrical and electronic equipment labeling..................................................................................... 45

ENERGY STAR® Qualified .......................................................................................................................................... 45
Warranty Information.................................................................................................................................................. 46

Index
Declaration of Conformity.......................................................................................................................................... 47
www.kodak.com/go/aiosupport  v





1 Printer Overview
This printer lets you print, copy, and scan pictures and documents. 

Components

1 Memory card slot 8 Printhead with ink cartridges installed

2 Control panel 9 Right paper-edge guide

3 LCD 10 Paper tray

4 USB port 11 Paper tray extender / paper stop

5 Power cord connection port 12 Left paper-edge guide

6 Rear-access cleanout area 13 Scanner glass

7 Printer access door 14 Scanner lid
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Printer Overview
Control panel 

Feature Description

1 LCD Displays pictures, messages, and menus

2 On/Off button Turns the printer on or off

3 Home button Displays the main menu, and toggles between screens

4 Navigation buttons Used to navigate menus, scroll through pictures

5 Start button Begins copying, scanning, printing, maintenance task, and file transfer

6 Cancel button Stops the current operation and returns to the menu; returns to previous item when 
navigating menus

7 OK button Selects a menu item, accepts a zoom setting, and lets you continue with the current 
operation

8 Back button Displays the previous screen
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KODAK ESP 3200 Series All-in-One Printer
Home Center Software 
KODAK Home Center Software is installed as part of the software installation on 
your computer. The Home Center icon will appear on your desktop. Use this icon to 
start Home Center Software.

Home Center 
Software for 
WINDOWS 
OS-based 
computers

On a WINDOWS OS-based computer, you can use Home Center Software to 
browse and edit pictures, print, copy, scan, order supplies, access the Extended User 
Guide, and configure your all-in-one printer from your computer. You can also 
access the KODAK Tips and Projects Center Web site or upgrade your printer with a 
newer version of software and/or firmware. 

Clicking one of the three icons located in the upper-right corner of Home Center 
Software does the following:

Home Center 
Software for 
MACINTOSH 
Computers

On a MACINTOSH Computer, Home Center Software has three panes: Select, Tools, 
and Maintenance. These panes let you do the following: 

Select pane — select your printer from a list of connected printers and check the 
printer ink levels. 

Tools pane — start a scan, select scanning settings, change Home Center Software 
settings, and restore all factory default settings.

Maintenance pane — print a test page, align and clean the printhead, and initiate an 
upload of diagnostic data for service personnel.

From any pane, you can order supplies from the KODAK Web site and view the 
status of your printer. 

From the File menu of Home Center Software, you can check for software updates. 

Home - takes you to the main Home Center Software window from other functions 
within Home Center Software

Tools - displays menu options, including links to Kodak sites, troubleshooting, and 
maintenance functions

Help - displays a Help panel for Home Center Software
www.kodak.com/go/aiosupport 3



2 Configuring Your Printer
This chapter presumes that you have set up your printer and that you may or may 
not have installed the printer software.

Configuring printer settings

Configuring basic 
printer settings

NOTE: When you first power on the printer, the printer automatically steps you 
through the process of selecting the Language.

To set or change basic printer settings: 

1. Press Home.

2. Press  to select Printer Settings, then press OK.

3. Press  to select one of the following settings: 

• Date and Time*

– Press OK, then press  to select Year, Month, Day, Hour, or Minute. 
Press or  to change the values; press OK when you are done.

• Time to Low Power 

– Press  to change the time to energy-saving low power (select from 1 to 4 
hours in 0.5 hour increments). After the Time to Low Power, the printer 
goes into a low-power mode.

• Tagged Images Printing (see Printing tagged pictures, page 14)

– Press  to select On or Off. 
If you select On, when you are printing pictures, the printer LCD prompts 
you to verify that you want to print pictures that were tagged (or marked) 
using your camera. Different cameras use different terminology; KODAK 
Digital Cameras use “marked” images; others use either tagged images or 
DPOF.

• Language
– Press OK, press  to select a language, then press OK.

• Reset All Settings (see Resetting factory defaults, page 34)

NOTE: Resetting factory defaults does not change the date and time, language, or 
country/region.

4. Press Back. 

* You can also synchronize the printer's date and time to your computer from Home 
Center Settings under Tools in Home Center Software.
4 www.kodak.com/go/aiosupport



KODAK ESP 3200 Series All-in-One Printer
Setting your 
printer as the 
default printer

If you have more than one printer, and after installation your all-in-one printer was 
not the default printer, you can make your all-in-one printer your default printer. 

For all computers and operating systems: If you haven’t yet installed the printer 
software, insert the software CD that came with your printer and follow the 
on-screen instructions to install the software.

For WINDOWS XP OS-based computers

1. Select Start > Control Panel > Printers and Faxes.

2. Right-click your printer, and select Set as Default Printer. 

For WINDOWS VISTA OS-based computers

1. Select Start > Control Panel > Hardware and Sound > Printers.

2. Right-click your printer, and select Set as Default Printer.

For WINDOWS 7 OS-based computers

1. Select Start > Control Panel > Hardware and Sound > Devices and Printers.

2. Right-click your printer, and select Set as Default Printer.

For MACINTOSH Computers

When a new printer is installed, it becomes the default printer. If your all-in-one 
printer is not the default printer:

1. From the dock, open System Preferences.

2. In the Hardware section, click Print & Fax.

3. Select your printer from the drop-down list next to Default Printer.

Connecting to another KODAK All-in-One Printer
If you are connecting to a newer model printer (for example, you already have an 
ESP 7 printer and now you adding an ESP 3250 printer), you must install the 
software for the newer model.

If you are connecting to another ESP 3250 printer or to an older model:

• On a WINDOWS OS-based computer:

a. Select Start > All Programs > Kodak > Kodak Printer Network Setup Utility.

b. If your all-in-one printer is not listed: 

• Select No, my printer is not listed, then click Next.

• From the drop-down list, select your printer.

• Select USB Cable - connect your cable now. 

• Connect the USB cable to the computer and printer.

• Click Next. 
When your printer is detected, driver installation begins
www.kodak.com/go/aiosupport 5



Configuring Your Printer
c. If your all-in-one printer is listed:

• Highlight the all-in-one printer that is connected to your network.

• Select Yes, my printer is listed, then click Next.
When your printer is detected, driver installation begins.

d. When driver installation is complete, click Done. 

• On a MACINTOSH Computer:

a. From the dock, open System Preferences.

b. Click Print & Fax.

c. Click the + sign to add the printer.

d. Select the printer from the list of available printers, then click Add.
6 www.kodak.com/go/aiosupport



3 Handling Paper
For the best photo printing results, use KODAK Photo Papers, which are optimized to 
work with KODAK All-in-One Printers. 

For the best document printing results, use KODAK Document Papers or a paper 
with the COLORLOK Technology logo on the package. Use only paper that is 
designed for inkjet printers.

When handling paper:

• Hold the paper by the edges; avoid placing your fingerprints on it.

• Do not touch the glossy side of photo paper.

• Store paper flat, away from direct sunlight and heat.

Paper types
You can use: 

• Plain paper — 20 to 24 lb / 75 to 90 gsm

• Photo paper — up to 12 mil (290 gsm)

• Card stock — 110 lb / 200 gsm, max

• Envelopes — most standard types

• Transparencies — inkjet variety with white stripe

• Labels — all inkjet varieties on 8.5 x 11-in. or A4 sheets

• Iron-on transfers — all inkjet varieties on 8.5 x 11-in. or A4 sheets

Paper sizes
The printer accepts the following paper sizes: 

• 4 x 6 in. / 101 x 152 mm

• 4 x 7 in. / 101 x 178 mm

• 4 x 12 in. / 101 x 305 mm

• 5 x 7 in. / 127 x 178 mm

• 8 x 10 in. / 203 x 254 mm

• 8.5 x 11 in. / 216 x 279 mm

• 8.5 x 14 in. / 216 x 356 mm

• A4 (8.27 x 11.69 in. / 210 x 297 mm) 

• A5 (5.83 x 8.27 in. / 148 x 210 mm)

• A6 (4.13 x 5.83 in. / 105 x 148 mm)

• B5 (6.93 x 9.48 in. / 176 x 250 mm)

NOTE: Do not load paper smaller than 4 x 6 in. / 101 x 152 mm or A6.
www.kodak.com/go/aiosupport  7



Handling Paper
Envelope sizes
The printer accepts the following envelope sizes: 

• C5 (6.38 x 9 in. / 162 x 229 mm)

• C6 (4.5 x 6.38 in. / 114 x 162 mm)

• DL (4.31 x 8.69 in. / 110 x 220 mm)

• US #7¾ (3.88 x 7.5 in. / 98 x 190 mm)

• US #9 (3.88 x 8.88 in. / 98 x 225 mm)

• US #10 (4.13 x 9.5 in. / 105 x 241 mm)

IMPORTANT: Do not load envelopes with cutouts or with cellophane windows. 

Loading paper

Loading plain 
paper

The paper tray capacity is 100 sheets of plain paper.

To load plain paper:

1. Open the paper tray. 

2. Pull out the paper tray extender until it is fully extended. 

3. Lift the paper stop.

4. Make sure the left paper-edge guide is to the far left. 
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KODAK ESP 3200 Series All-in-One Printer
5. Carefully fan and stack the paper, then insert it into the tray.

6. Move the paper forward until it stops.

7. Move the left paper-edge guide until it touches the paper.

Loading photo 
paper 

The paper tray capacity is 20 sheets of photo paper.

To load photo paper: 

1. Remove any paper from the tray.

2. Carefully fan and stack the photo paper, then insert the paper (short side first) 
into the tray with the logo side facing up.

3. Move the paper forward until it stops.

4. Move the left paper-edge guide until it touches the paper.
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Handling Paper
Loading 
envelopes

The paper tray capacity is 20 envelopes.

To load envelopes: 

1. Remove any paper from the tray.

2. Insert the envelope(s) into the tray with the flap up and against the right side of 
the tray.

3. Move the left paper-edge guide until it touches the envelope(s). 

left paper-edge guide 
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4 Printing Pictures
The quickest way to print pictures is from a memory card inserted into the printer. 

Another way to print pictures is to use Home Center Software on your computer 
running the WINDOWS Operating System. Home Center Software lets you edit and 
enhance your pictures on your computer before printing. Open Home Center 
Software, select Print Pictures, then follow the on-screen instructions. 

If you have a MACINTOSH Computer, print your pictures using KODAK 
EASYSHARE Software, iPhoto, or another picture-editing program. 

Changing Print Photos Options / Defaults
You can change the print photos options for an individual picture or group of 
pictures, or you can change the settings and save them as the default. 

To change print photos options: 

1. Press Home.

2. If necessary, press  to select View and Print Photos, then press OK.

3. Press or  as needed to change the settings below. 

Print Photos Option Settings Description

View Photos -- Scroll through the pictures on the 
memory card.

Transfer All to PC -- To transfer all the pictures on the 
memory card to your computer, press 
OK then Start. (Your printer and 
computer must be connected with a USB 
cable.)

Quantity 1 (default) to 99 The number of copies that print.

Print Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

If the selected copy size is smaller than 
the paper in the paper tray, the printer 
automatically arranges the pictures to 
best fit the paper size. 

Plain Paper Quality Normal (default) Good quality output; prints faster than 
Best.

Best The highest quality.

Draft The fastest print speed.

Photo Paper Quality Automatic
(default)

The printer detects when you load photo 
paper and sets Best quality 
automatically.
www.kodak.com/go/aiosupport  11



Printing Pictures
Printing pictures from a memory card

Types of memory 
cards

Your printer accepts the following memory cards: 

• SD Card

• SDHC Card

• MMC Card

• Memory Stick

• Variations of the memory cards listed above that require an adapter (for 
example, MEMORY STICK Duo, miniSD, and microSD)

IMPORTANT: If you use a memory card with an adapter, make sure you insert and remove 
the adapter and the memory card as a unit; do not remove the memory card 
while leaving the adapter in the printer.

Printing a picture 
using the default 
settings

If you use the default settings, one 4 x 6 in. /101 x 152 mm picture is printed.

To print a picture: 

1. Load photo paper with the logo side facing up (see Loading photo paper, 
page 9), and move the left paper-edge guide until it touches the paper.

Color Color (default) Prints full color.

Black & White Prints black and white (gray scale).

Scene Balance On (default)
Off 

Adjusts the image brightness to correct 
for underexposure and reduces the 
variation in contrast in different areas of 
the picture.

Add Date to Prints No (default)
Yes

Prints the date of the picture(s) (the date 
the picture was taken or last edited) in a 
corner of the print.

Save as Defaults No (default)
Yes

To save settings as the new default, press 
OK, select Yes, then press OK.

Print Photos Option Settings Description
12 www.kodak.com/go/aiosupport



KODAK ESP 3200 Series All-in-One Printer
2. Insert the memory card into the memory card slot. 

3. Press or  to display the picture you want to print.

4. Press Start to begin printing.

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.

Printing pictures 
using non-default 
photo options

To print pictures with options other than the default settings (such as a different 
print size, black-and-white instead of color, or a date on the print): 

1. Load photo paper with the logo side facing up (see Loading photo paper, 
page 9), and move the left paper-edge guide until it touches the paper.

2. Press Back.

3. If necessary, use the navigation buttons to select View and Print Photos.

4. Press OK.
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Printing Pictures
5. Press  to select the option you want to change (for example, Quantity, Print 
Size, Color, Scene Balance, or Add Date to Print).

6. Press  to change the selection.

7. Repeat steps 5 and 6 for each option you want to change. 

8. When you are done changing options, press  to select View Photos, then 
press OK.

9. Insert the memory card into the memory card slot. 

10. Press or  to select the picture you want to print, then press OK. A check 
mark on the LCD indicates the picture is selected. 

NOTE: To deselect the picture, press OK again.

11. To select additional pictures, press or  until the picture is displayed, then 
press OK. 

12. When you are done selecting pictures, press Start to begin printing. 

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.

Printing tagged 
pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for 
printing. This creates a tag that is recognized by the printer. If you choose to print 
tagged pictures, they will be printed according to the default settings on your printer 
(unless otherwise specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine whether your camera supports 
tagged (also “marked” or “DPOF”) functionality.

To print tagged pictures:

1. Load photo paper with the logo side facing up (see Loading photo paper, 
page 9), and move the left paper-edge guide until it touches the paper.
14 www.kodak.com/go/aiosupport



KODAK ESP 3200 Series All-in-One Printer
2. Insert the memory card into the memory card slot. 

3. When the “Print tagged images?” message appears, press Start.

Printing 
panoramic 
pictures

To print a panoramic picture, load 4 x 12 in. / 101 x 305 mm paper, or US letter or A4 
paper.

Transferring pictures to a computer
You can transfer .jpg, .mov, and .wav files from a memory card in the printer to your 
computer. To transfer these files, the printer must be connected to your computer 
with a USB cable.

NOTE: If you have large video files or a large number of pictures (400 or more), we 
recommend that you use a memory card reader attached directly to your 
computer to transfer them. 

Transferring 
pictures to a 
WINDOWS 
OS-based 
computer

1. Insert the memory card into the memory card slot on the printer. 

2. Press Back.

3. If necessary, use the navigation buttons to select View and Print Photos.

4. Press OK.

5. Press  to select Transfer All to PC, then press OK. 

6. Press Start.

7. Follow the on-screen instructions on your computer.

Transferring 
pictures to a 
MACINTOSH 
Computer

1. Insert the memory card into the memory card slot on the printer. 

2. Press Back.

3. If necessary, use the navigation buttons to select View and Print Photos.

4. Press OK.

5. Press  to select Transfer All to PC, then press OK. 

6. Press Start.

7. Use iPhoto or Image Capture on your computer to complete the transfer.
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5 Copying
You can copy documents and pictures with your all-in-one printer. The printer 
produces high–quality color or black-and-white copies on a variety of paper types 
(see Paper types, page 7). 

Making a copy
To copy a document or a picture using the default settings:

1. Lift the scanner lid, and place the document or picture face down on the glass. 

2. Close the lid.

NOTE: Single-button document copy is a feature that lets you put paper on the 
scanner and immediately press Start, without following the remaining steps 
below. You can use this feature when the printer has been idle or when it is 
turned on; the printer automatically goes to Copy Document mode.

3. Press Home.

4. If needed, press  or  to select Copy Document or Copy Photo.

5. Press Start to begin copying. 

Changing copy options
You can change the copy options for an individual copy, or you can change the 
settings for copying documents or copying photos, and save them as the defaults. 

Changing copy 
document options 

To change the copy document options: 

1. Press Home. 

2. If necessary, press  to select Copy Document.

3. Press OK.
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KODAK ESP 3200 Series All-in-One Printer
4. Press  to go through the options, and press  or  as needed to change the 
settings below:

Copy Document Option Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Copy Size Same Size 
(default)

The copy is the same size as the 
original.

Fit to Page The printer detects the size of the 
original on the scanner glass and the 
size of the paper in the paper tray, and 
automatically reduces or enlarges the 
original so that the copy fits on the 
paper.

20% to 500% Reduces up to 20% or enlarges up to 
500% of the original size.

Plain Paper Quality Normal
(default)

Good quality output; prints faster than 
Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs when 
printing Draft or Normal.

Draft The fastest print speed, but the lowest 
quality.

Photo Paper Quality Automatic
(default)

The printer detects when you load 
photo paper and sets Best quality 
automatically.

Color Color 
(default)

Prints full color.

Black & White Prints black and white (gray scale).

Brightness -3 to +3 
(0 is default) 

Lightens or darkens the copy. 
0 (Normal) is no change from the 
original; -3 is the darkest; +3 is the 
lightest.

Save as Defaults No / Yes To save settings as the new default: 
press OK, select Yes, then press OK.
www.kodak.com/go/aiosupport 17



Copying
Changing copy 
photo options 

To change the copy photo options: 

1. Press Home. 

2. If necessary, press  to select Copy Photo.

3. Press OK.

4. Press  to view the options, and press  or  as needed to change the settings 
below:

Copy Photo Option Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Copy Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size. 

Plain Paper Quality  Normal 
(default)

Good quality output; prints faster 
than Best.

Best The highest quality.

Draft The fastest print speed.

Photo Paper Quality Automatic
(default)

The printer detects when you load 
photo paper and sets Best quality 
automatically.

Color Color 
(default)

Prints full color.

Black & White Prints black and white (gray scale).

Brightness -3 to +3 
(0 is default) 

Lightens or darkens the copy. 
0 (Normal) is no change from the 
original; -3 is the darkest; +3 is the 
lightest.

Save as Defaults No / Yes To save settings as the new default: 
press OK, select Yes, then press 
OK.
18 www.kodak.com/go/aiosupport



KODAK ESP 3200 Series All-in-One Printer
Adjusting copy settings
You can change the copy settings for individual copy tasks. A few of the common 
tasks are described below.

Enlarging or 
reducing a 
document

To enlarge or reduce the size of your copy:

1. Lift the scanner lid, and place the document face down on the glass. 
Note the orientation of the paper on the glass and make sure the paper is flush 
to the edges.

2. Close the lid.

3. Press Home.

4. If needed, press  or  to select Copy Document.

5. Press OK.

6. Press  to select Copy Size.

7. Press  or  to select the enlargement or reduction you want.

NOTE: If you select Fit to Page, the printer detects the size of the original on the 
scanner glass and the size of the paper in the paper tray, and automatically 
reduces or enlarges the original so that the copy fits on the paper

8. Press Start to begin copying. 

Enlarging or 
reducing a photo

To enlarge or reduce the size of your copy:

1. Lift the scanner lid, and place the photo face down on the glass. 

2. Close the lid.

3. Press Home.

4. If needed, press  or  to select Copy Photo.

5. Press OK.

6. Press  to select Copy Size.

7. Press  or  to select the photo size you want.

8. Press Start to begin copying. 

MS     SD/HC     MMC

Back Home
www.kodak.com/go/aiosupport 19



Copying
Darkening or 
lightening copies

If the original document or picture is too light or too dark, you can make the copy 
darker or lighter. 

To darken or lighten the copy:

1. Lift the scanner lid, and place the document face down on the glass. 

2. Close the lid.

3. Press Home.

4. If needed, press  or  to select Copy Document or Copy Photo.

5. Press OK.

6. Press  to select Brightness.

7. Press  to select a number below zero for a darker copy, or press  to select a 
number above zero for a lighter copy.

8. Press Start to begin copying. 

MS     SD/HC     MMC

Back Home
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6 Scanning
Scanning converts the text and images from the documents and pictures that you 
place on the scanner glass into electronic data, and then sends the data to your 
computer. To scan with your all-in-one printer, it must be connected to a computer 
with a USB cable.

You save the scanned file(s) to your computer; you cannot save to a memory card in 
the printer. 

Before you begin scanning
Change the default scan settings in the Home Center Software. (Click the Tool icon, 
then select Printer Scan Settings.)You can adjust the following settings for scanned 
pictures and documents:

• Color / black-and-white / gray scale

• Resolution (dpi) 

• File format (.pdf, .rtf, .tif, .jpg for documents; .jpg, .bmp, .tif for pictures)

• Base name (by default, scanned files are named “scan1”, “scan2”, etc)

• Location (folder) where the scanned files will be saved

Before saving a scanned file, you can preview it in Home Center Software, and crop 
the output as desired. See the Home Center Software Help (? icon) for instructions.

Simple scanning
To scan a single document or picture: 

1. Lift the scanner lid, and place the document or picture face down on the glass. 

2. Close the lid.

3. Open Home Center Software, then:

• On a WINDOWS OS-based computer, select Scan Pictures and Documents, 
then follow the on-screen instructions.

• On a MACINTOSH Computer, select Tools > Scan Application, then follow 
the on-screen instructions. 

MS     SD/HC     MMC

Back Home
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Scanning
Scanning multiple pictures simultaneously 
Using Home Center Software, you can scan multiple pictures simultaneously and 
save them as separate files. 

NOTE: For Home Center Software to interpret two or more pictures, the scan option 
must be set to Picture. 

When scanning multiple pictures, leave space between the pictures so that the 
printer can detect the separate pictures. Any pictures that overlap are interpreted as 
a single picture. 

Scanning multiple 
pictures with a 
WINDOWS 
OS-based 
computer

To scan multiple pictures simultaneously and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, then select Scan Pictures and Documents. 

4. Open the Tools panel, if it is not open, by clicking the Tools icon.

5. Click Printer Scan Settings.

6. Select the Picture tab.

7. Select Automatically Detect Pictures, if it is not selected, then click OK.

8. Make sure Picture is selected, then follow the on-screen instructions. 

NOTE: Click the Help icon for additional instructions. 

Scanning multiple 
pictures with a 
MACINTOSH 
Computer 

To scan multiple pictures simultaneously and save them as separate files: 

1. Lift the scanner lid, and place the pictures face down on the glass leaving space 
between the pictures. 

2. Close the lid. 

3. Open Home Center Software, then select the Tools tab.

4. Select Color Picture or Black and White Picture.

5. Click the Scan Application button.

6. Select Automatically detect multiple pictures, if it is not selected.

7. Click Preview or Scan All, and follow the on-screen instructions.

NOTE: Click the Help icon for additional instructions. 
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7 Maintaining Your Printer
Your printer requires little maintenance. However, Kodak recommends cleaning the 
scanner glass and lid regularly to remove dust and fingerprints, which affect the 
quality and accuracy of scanning.

Except for cleaning the printer, keep the printer plugged in with AC power turned on. 
If you use a power strip, don't turn off the power strip.

Keep the printhead and ink cartridges in the printer at all times. This helps prevent 
damage to the printhead.

Service agreements are available in some countries. Contact dealers of KODAK 
Products for more information. 

For recycling and/or disposal information, contact your local authorities. In the US, 
go to the Electronics Industry Alliance at www.eia.org or go to 
www.kodak.com/go/recycle. 

General care and cleaning
CAUTION:

Always disconnect the power to the printer before cleaning it. Do not use 
harsh or abrasive cleaners or organic solvents on the printer or any of its 
parts.

• To clean the printer, wipe the outside with a clean, dry cloth.

• Keep the surrounding area vacuumed and litter-free. 

• Protect the printer from tobacco smoke, dust, sand, other small particles (such 
as crumbs), and liquid spills. 

• Do not place objects on the printer. 

• Keep the printer supplies away from direct sunlight and out of high-temperature 
environments.

• Do not allow chemicals, such as suntan lotion, to come into contact with the 
painted surface of the printer. 

• If the printer has been exposed to bad weather or has water inside it, turn it off 
and let it dry completely. If this does not solve the problem, contact Kodak 
Service & Support.
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Maintaining Your Printer
Cleaning the 
scanner glass

For good quality copies and scans, ensure the printer's scanner glass and lid backing 
are clean; dust the exterior as needed. 

CAUTION:
Do not use abrasives, acetone, benzene, or carbon tetrachloride on the glass, 
as these chemicals may damage it. Do not pour or spray liquid directly on the 
glass; the liquid might seep under the glass and damage the printer.

To clean the scanner glass: 

1. Unplug the printer and raise the scanner lid. 

2. Wipe the glass with a soft cloth or sponge, slightly moistened with a 
nonabrasive glass cleaner. 

3. Dry the glass with a lint-free cloth.

4. When finished cleaning, plug in the printer.

MS     SD/HC     MMC

Back Home
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KODAK ESP 3200 Series All-in-One Printer
Cleaning inside 
the scanner lid

Minor debris can accumulate on the white document backing located under the 
scanner lid. 

CAUTION:
Do not use paper-based wipes, as they can scratch the underside of the 
scanner lid. Do not use harsh or abrasive cleaners or organic solvents on the 
printer or any of its parts.

To clean the white document backing under the scanner lid: 

1. Unplug the printer and raise the scanner lid.

2. Gently clean the underside of the lid with a soft cloth or sponge, slightly 
moistened with a mild soap and warm water. 

3. Dry the underside with a chamois or soft cloth.

4. If the white document backing needs further cleaning, use isopropyl (rubbing) 
alcohol on a soft cloth, then wipe thoroughly with a cloth damped with water to 
remove any residual alcohol. 

5. When finished cleaning, plug in the printer.

MS     SD/HC     MMC

Back Home
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Maintaining Your Printer
Replacing ink cartridges
Your printer uses both black and color ink cartridges. You can check the approximate 
ink levels on the LCD (see Checking ink levels, page 34) or in Home Center Software. 
When an ink cartridge is out of ink, the printer LCD displays a message stating that 
the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.
To replace an ink cartridge: 

1. Make sure your printer is on.

2. Lift the printer access door, and wait for the carriage to move to the access 
position.

The black and color ink cartridges are located in the printhead. 

black ink cartridge

color ink cartridge

printhead 
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KODAK ESP 3200 Series All-in-One Printer
3. Pinch the latch on the ink cartridge and lift it out of the printhead. 

4. Remove the ink cartridge from its bag.

IMPORTANT: Insert the ink cartridge into the printhead immediately to prevent the 
printhead from drying out. 

5. Remove the protective cap from the cartridge.

10
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Maintaining Your Printer
6. Insert the ink cartridge into the printhead.

7. Press down on the tab until you hear a click.

8. Close the printer access door. 
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KODAK ESP 3200 Series All-in-One Printer
Replacing the printhead
IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace 

the printhead only if you receive a new printhead from Kodak.
To replace the printhead:

1. Make sure your printer is on.

2. Lift the printer access door, and wait for the carriage to move to the access 
position.

3. Remove any paper that may be loaded in the printer. 

4. Remove both ink cartridges and set them aside. 
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Maintaining Your Printer
5. Unlatch the used printhead by lifting the button in the center of the carriage.

6. Lift the used printhead out of the carriage.

7. Remove the new printhead from its bag.

CAUTION:
Do not touch the copper contacts on the printhead, as this may damage it.
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KODAK ESP 3200 Series All-in-One Printer
8. Remove the two plastic protective shields.

9. Place the new printhead into the carriage. Insert it at the angle shown.
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Maintaining Your Printer
10. Push firmly against the target label of the printhead until you hear a loud snap.

11. Insert the black ink cartridge into the printhead. 

12. Press down on the ink cartridge until you hear it click into position.

13. Repeats steps 11 - 12 for the color ink cartridge. 

14. Close the printer access door. 

The printer detects the new printhead. Follow the instructions on the LCD to 
calibrate your printer. 

10

Cartouche d'encre noire

10
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KODAK ESP 3200 Series All-in-One Printer
Upgrading the printer software and firmware
Using the latest software and firmware helps ensure optimal performance of your 
printer. 

When you upgrade to the latest version of Home Center Software, it comes with the 
latest drivers, which are programmed links between the computer and printer. The 
drivers allow communication between the printer, scanner, and computer. 

Firmware is data or programs that are written to the memory and control 
functionality of your printer. 

When you open Home Center Software, the software automatically checks for 
software and firmware updates (firmware updates on WINDOWS OS-based 
computers only). Use these procedure when you want to upgrade manually.

NOTE: Your printer must be connected to the computer with a USB cable to 
upgrade firmware.

Upgrading 
software and 
firmware on a 
WINDOWS 
OS-based 
computer

To upgrade the software and firmware:

1. Make sure that your computer is connected to the Internet. 

2. Connect the printer to the computer with a USB cable (if not currently 
connected). 

3. Open Home Center Software.

4. Click the Tools icon to open the side navigation pane.

5. Under Web Links, click Software Updates to check whether software updates 
are available.

6. If there are updates, click Next and follow the on-screen instructions. 

7. Under Web Links, click Firmware Updates to check whether firmware updates 
are available.

8. If there are updates, click Next and follow the on-screen instructions.

Upgrading 
software and 
firmware on a 
MACINTOSH 
Computer

To upgrade the software:

1. Make sure that your computer is connected to the Internet. 

2. Open Home Center Software.

3. On the File menu, select Check for Updates.

4. If there are software updates, follow the on-screen instructions for upgrading 
your software.

To upgrade the firmware:

1. Go to www.kodak.com/go/esp3250downloads.

2. Connect the printer to the computer with a USB cable (if not currently 
connected). 

3. Select your operating system from the drop-down list.

4. Click Select in the Firmware box.

5. Read the instructions, click Download, then follow the on-screen instructions.
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Maintaining Your Printer
Monitoring and adjusting printer performance
From the control panel, you can perform many tasks to help you keep the printer 
functioning well.

Checking ink 
levels

To check the ink levels: 

1. Press Home.

2. Press  to select Maintenance.

3. With Check Ink Levels selected, press OK.

The LCD shows approximate levels of ink in the cartridges so you know when it’s 
time to order replacement cartridges. 

Resetting factory 
defaults

To reset all defaults to the factory default settings: 

1. Press Home.

2. Press  to select Printer Settings.

3. Press  to select Reset All Settings, then press OK. 

4. When you see the message, “This will reset printer settings to factory defaults,” 
press OK.
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8 Troubleshooting

Basic troubleshooting
Some problems can be resolved quickly by power cycling the printer: Turn off your 
printer. Wait five seconds. Turn on the printer. 

Use the following information to help troubleshoot problems with your printer.

For more troubleshooting information, go to:

• www.kodak.com/go/itg to use our Step-by-Step Solutions and Repair tool for 
help with problems such as paper jams and image quality.

• www.kodak.com/go/esp3250support for FAQs and links to other support for 
your printer.

• www.kodak.com/go/esp3250downloads to download the latest software and 
firmware files.

• www.kodak.com/go/esp3250specs for the recommended system requirements.

Problem Possible Solutions

Printer does not power on • Make sure you are using the power cord that came with your printer. 
• Make sure the power cord is connected to the AC adapter and is plugged 

into an outlet or power strip.
• If the USB 2.0 cable was disconnected from the printer, then reconnected, or 

if power to the printer was interrupted, restart the computer.

Printer not detected • Make sure your printer is plugged in and turned on.
• Make sure: 

– you have a USB 2.0 cable.

– that the USB cable is connected to both your printer and your computer.

Printhead carriage jam • Open the printer access door and clear any obstructions.
• Check that the printhead and ink cartridges are installed correctly.

(The printhead and ink cartridges are installed correctly when you hear 
them click into place.)

Image quality problems • For best results, use KODAK Paper or a paper with the COLORLOK 
Technology logo on the package.

• Make sure the paper is loaded correctly. See Loading paper, page 8 
5. For more help, go to www.kodak.com/go/itg, select All-in-one printer, 

then Print Quality (missing colors, blank prints, etc).

Ink cartridge problems • Check that KODAK Ink Cartridge(s) are installed. Do not use non-Kodak 
brand or refilled ink cartridges. 

• Remove, then install the cartridges again. Make sure the cartridges click into 
place.
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Troubleshooting
For more troubleshooting information, go to www.kodak.com/go/esp3250support.

Status light
The status light indicates the condition of the printer. 

Power status light

Paper jam • Check for paper in the rear-access cleanout area.
• Open the printer access door and gently remove any paper from inside the 

printer. 
• Make sure the paper in the tray is free of tears or creases.
• Make sure you do not overload the paper tray.
For more information, see www.kodak.com/go/itg. Select All-in-one printer, 
then Paper jam.

Error messages or other 
problems you cannot 
resolve

If you need to contact Kodak (see www.kodak.com/go/contact), have the 
following information available:

• Kodak Service Number (located inside or on the outside of the printer)
• Printer mode number (located on the back of the printer)
• Computer model, operating system, and version of Home Center Software
• Exact wording of any error message(s)

Problem Possible Solutions

Power light What it means

Off • The printer is turned off.

– Press the on/off button to turn on power.
• The printer does not have power.

– Make sure that the power cord is plugged into the back of the printer and 
into an electrical outlet, and that the electrical outlet has power.

Blinking • The printer is busy.

– Wait for the printer to finish the task.

On • The printer is ready
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9 Product and Safety Specifications
Specifications for this KODAK ESP 3200 Series All-in-One Printer are described in 
the tables below.

Specifications and features

Print performance

Photo printing features

Print Performance

Black Print Speed Up to 30 pages per minute on plain paper

Color Print Speed Up to 29 pages per minute on plain paper

Print Technology Continuous-tone, thermal inkjet

Print Quality Modes Draft, Normal, and Best on plain paper

Photo quality mode on photo paper

Photo Printing Features

Quantity Up to 99 
(may vary for different models of the 3200 series printers)

Print Sizes 2 x 3 in. (5 x 7.6 cm)

3.5 x 5 in. (9 x 12.7 cm)

4 x 6 in. (10 x 15 cm)

4 x 7 in. (10 x 18 cm)

(Panoramic) 4 x 12 in. (10 x 30 cm)

5 x 7 in. (13 x 18 cm)

8 x 10 in. (20 x 25 cm)

US Letter - 8.5 x 11 in. (22 x 28 cm)

A4 (21 x 30 cm)

Quality Best, Normal, Draft

Auto-detect Media Auto-detect plain paper, photo paper, and transparency

Optimize image quality for KODAK Photo Papers with barcode

Image Enhancement KODAK PERFECT TOUCH Technology with 
Home Center Software

Add Dates to Prints Yes, No

Color Color, Black-and-white

Scene Balance On, Off
www.kodak.com/go/aiosupport  37



Product and Safety Specifications
Copy document features

Copy photo features

Scanning features

Copy Document Features

Color Black-and-white or color

Quantity 1 to 99 copies 
(may vary for different models of the 3200 series printers)

Copy Sizes Same Size, Fit-to-Page, 20% to 500% 
(may vary for different models of the 3200 series printers)

Plain Paper Quality Best, Normal, Draft

Brightness – 3 to + 3

Copy Photo Features

Color Black-and-white or color

Quantity 1 to 99 copies 
(may vary for different models of the 3200 series printers)

Copy Sizes 2 x 3 in. (5 x 7.6 cm)

3.5 x 5 in. (9 x 12.7 cm)

4 x 6 in. (10 x 15 cm)

4 x 7 in. (10 x 18 cm)

(Panoramic) 4 x 12 in. (10 x 30 cm)

5 x 7 in. (13 x 18 cm)

8 x 10 in. (20 x 25 cm)

US Letter - 8.5 x 11 in. (22 x 28 cm) 

A4 (21 x 30 cm)

Quality Automatic

Brightness – 3 to + 3

Scanning Features

Scanner Type Contact Image Sensor (CIS)

Maximum Scan Size 8.5 x 11.7 in. (21.6 x 29.7 cm)

Functions Segmentation scanning

Auto-destination

OCR
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KODAK ESP 3200 Series All-in-One Printer
Paper tray features

Ink cartridges

Connectivity

Software support

Paper Tray Features

Paper Capacity 100 sheets of 20 lb plain paper

20 sheets of photo paper, up to 12 mil (290 gsm)

20 envelopes

Tray Size 4 x 6 in. to 8.5 x 14 in. (10 x 15 cm to 21.6 x 36 cm)

Ink Cartridges

Ink Handling 2-cartridge, 6-ink system

Ink Life 1-year warranty from date of purchase

Connectivity

Protocols Supported USB 2.0, DPOF, MIPC

Devices Supported WINDOWS OS-based and MACINTOSH Computers, memory 
cards (SD, MS/Duo, MMC, SDHC) 

Image Formats Supported Image printing supports JPEG (EXIF v2.2); does not support 
progressive JPEG format

Number of USB Ports One rear device port (high speed)

Protocols Supported USB 2.0, DPOF (Tagged image printing), MIPC 

Software Support

Application Support KODAK EASYSHARE Software for photos or third-party image 
management applications; optical character reader (OCR) 
support for documents

Media Support Plain paper, photo paper, envelopes, greeting cards, 
transparencies with white stripe, labels

Scanner Support TWAIN and WIA, WIA2 (VISTA OS) import, including 
EASYSHARE Software, segmentation scanning

Update Support Software and firmware updates available through Web support
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Product and Safety Specifications
Physical specifications

Warranty

System requirements
The following specifications are subject to change without notice.

WINDOWS OS-based computer

Physical Specifications

Power US: 110–120 V AC, 50–60 Hz at 2 A

WW: 110-240 V AC, 50-60 Hz at 2 A

Output: 36 V DC at 1.6 A

Dimensions 422 x 98 x 181 mm [L × H x D] 
(16.6. x 11.7. x 7.1 in.)

Weight 5.6 kg (12.3 lb)

Operating Range 5°C (41°F) to 35°C (95°F), 15 to 85% RH

(non-condensing and atmospheric pressure to approximately 
10,000 ft ASL)

Full image Quality 
Environmental Range

15°C (59°F) to 30°C (86°F), and 20 to 80% RH. 
ENERGY STAR® Qualified 

Warranty

Product One year from purchase (with proof of purchase)

Printhead One year from purchase (with proof of purchase)

WINDOWS OS-Based 
Computer

Minimum Recommended

Operating System MICROSOFT WINDOWS 
XP SP2 OS

MICROSOFT WINDOWS 
VISTA OS

CPU Celeron 32- or 64-bit processor

Clock Speed 1.2 GHz 2 GHz

Memory 512 MB RAM 1024 MB RAM

Available Disk Space 500 MB available 500 MB available

Interface USB 2.0 USB 2.0

Removable Drive CD-ROM CD-ROM

Other Internet access capability Internet access capability
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KODAK ESP 3200 Series All-in-One Printer
MACINTOSH Computers

Paper types supported

MACINTOSH 
Computers

Minimum Recommended

Operating System MACINTOSH OS X 10.4.8 OS X 10.4.8 or later

CPU PowerPC G4, G5, or Intel Based 
Mac

Intel Based Mac

Clock Speed 1.2 GHz 2 GHz

Memory 512 MB RAM 1024 MB RAM

Available Disk Space 200 MB available 200 MB available

Interface USB 2.0 Full Speed USB 2.0 High Speed

Removable Drive CD-ROM CD-ROM

Other Internet access capability Internet access capability

Paper Types Supported

Plain Paper 20 to 24 lb (60 to 90 gsm)

Photo Paper Up to 12 mil (290 gsm)

Card Stock 110 lb index max (200 gsm)

Envelopes 20 to 24 lb (75 to 90 gsm)

Transparencies All commercially available inkjet varieties (with a white stripe)

Labels All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets

Iron-on Transfers All commercially available inkjet varieties on 8.5 x 11 in. and A4 
size sheets
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Product and Safety Specifications
Paper sizes supported

Safety information
• Always follow all warnings and instructions marked on the product.

• Use only the power source indicated on the product regulatory label.

• Use only the power cord that comes with the product. Using another power cord 
may cause fire and/or shock. Do not use the included power cord with any other 
equipment. 

Paper Sizes Supported

Usage Size

Document Page Sizes 

Labels

A4 (210 x 297 mm)

A5 (148 x 210 mm)

A6 (105 x 148 mm)

B5 (176 x 250 mm)

US Executive (7.25 x 10.5 in.) (184 x 266 mm)

US Letter (8.5 x 11 in.) (216 x 280 mm)

US Legal (8.5 x 14 in.) (216 x 356 mm)

Custom sizes from 4–8.5 in. wide and 6–14 in. long

Index Card Stock 4 x 6 in. index cards (101 x 152 mm)

5 x 7 in. index cards (127 x 178 mm)

Transparency

Iron-on Transfer 

A4 (210 x 297 mm)

US Letter (8.5 x 11 in.) (216 x 280 mm)

Label Sizes C5 (6.38 x 9 in.) (162 x 299 mm)

C6 (4.49 x 6.38 in.) (114 x 162 mm)

A2 (4.37 x 5.75 in.) (111 x 146 mm)

DL (designated long) (4.33 x 8.66 in.) (110 x 220 mm)

US #10 (4.12 x 9.5 in) (105 x 241 mm)

Photo 4 x 6 in. (102 x 152 mm)

4 x 7 in. (102 x 178 mm)

4 x 12 in. (102 x 305 mm)

5 x 7 in. (127 x 178 mm)

8 x 10 in. (203 x 254 mm)

US Letter (8.5 x 11 in.) (216 x 280 mm)

A4 (210 x 297 mm)

Greeting card 4 x 5.5 in. (101 x 140 mm)

4 x 8 in. (101 x 203 mm)
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KODAK ESP 3200 Series All-in-One Printer
• If you do not use this product for a long period of time, unplug it from the 
electrical outlet.

• Always turn this product off by using the On/Off button. Wait until the On/Off 
button stops flashing before removing the power plug from the outlet. 

• Do not allow the power cord to become damaged or frayed.

• If you need to use an extension cord with this product, make sure that the 
ampere rating of the product does not exceed the ampere rating of the extension 
cord.

• Place the product on a flat, stable surface that extends beyond the product’s 
base in all directions. This product will not operate properly if tilted or at an 
angle.

• When storing or transporting this product, do not tilt or stand it on its side. 
Never turn this product upside down (ink can leak out of the product).

• Avoid placing this product in an environment that is subject to rapid changes in 
temperature or humidity, mechanical shocks, vibration, or dust. Do not place 
near radiators, heating vents, or in direct sunlight.

• Leave enough room around this product for sufficient ventilation. 

• Do not block this product’s covers or openings, or insert any objects through 
slots. 

• Do not use aerosol products inside or around this product.

• Do not spill any liquid on this product.

• Do not attempt to repair or service this product.

• If the power cord or plug is damaged, if any liquid has been spilled onto the 
product, if the product has been dropped or the case damaged, if the product 
does not operate normally or exhibits a major change in performance level, 
unplug this product and contact Kodak at www.kodak.com/go/contact.

LCD screen safety
• Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or 

chemical cleaners.

• If the LCD screen is damaged, contact Kodak immediately. If any of the solution 
from the display gets on your hands, wash then thoroughly with soap and water. 
If the liquid crystal solution gets into your eyes, flush your eyes immediately 
with water. If any discomfort or change in vision persists after washing, seek 
medical attention immediately.

Ink cartridge safety
• Keep all ink cartridges out of the reach of children.

• If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush 
immediately with water. If any discomfort or change in vision persists after 
washing, seek medical attention immediately.

• For MSDS information on inks, go to www.kodak.com/go/MSDS.
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Product and Safety Specifications
Regulatory compliance

FCC statement The United states Federal Communications Commission (in CFR 47 Part 15.105) has 
specified that the following notice be brought to the attention of the users of this 
product:

Note: This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver

• Connect the product into an outlet on a circuit different from that to which the 
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

CAUTION:
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this 
product not expressly approved by Eastman Kodak Company might cause 
harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency 
exposure limits. Nevertheless, the product shall be used in such a manner 
that the potential for human contact during normal operation is minimized. 
This product and any attached external antenna, if supported, shall be placed 
in such a manner to minimize the potential for human contact during normal 
operation. In order to avoid the possibility of exceeding the FCC exposure 
limits, human proximity shall not be less than 20 cm (8 inches) during normal 
operation.

Canadian 
statements

This product meets the applicable Industry Canada technical specifications.

Operation is subject to the following two conditions: (1) this device may not cause 
interference, and (2) this device must accept any interference, including interference 
that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.
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Industry Canada (IC) Radiation Exposure Statement

This equipment complies with IC radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with a 
minimum distance of 20 cm between the radiator and your person.

German compliance statement 
Noise emissions for this equipment do not exceed 70 dBa.

This equipment is not intended for use in the work place in accordance with 
BildscharbV regulations.

“Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß 
BildscharbV vorgesehen.” 

REACH Article 33 declarations
Go to www.kodak.com/go/REACH for information about the presence of 
substances included on the candidate list according to article 59(1) of Regulation 
(EC) No. 1907/2006 (REACH).

Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. 
Contact your local authorities or go to www.kodak.com/go/recycle for recycling 
program information.

ENERGY STAR® Qualified

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an 
ENERGY STAR partner, KODAK has determined that this product meets ENERGY 
STAR Guidelines for energy efficiency. For more information on the ENERGY STAR 
program, see www.energystar.gov. 

 

www.kodak.com/go/aiosupport 45

http://www.kodak.com/go/reach
http://www.energystar.gov


Product and Safety Specifications
Warranty Information

Limited Warranty
Kodak warrants Kodak consumer electronic products and accessories (“Products”), excluding batteries, to be free from 
malfunctions and defects in both materials and workmanship for one year from the date of purchase. Retain the original dated 
sales receipt. Proof of the date of purchase will be required with any request for warranty repair.

Limited Warranty Coverage
Warranty service is only available from within the country where the Products were originally purchased. You may be required 
to send Products, at your expense, to the authorized service facility for the country where the Products were purchased. Kodak 
will repair or replace Products if they fail to function properly during the warranty period, subject to any conditions and/or 
limitations stated herein. Warranty service will include all labor as well as any necessary adjustments and/or replacement 
parts. If Kodak is unable to repair or replace a Product, Kodak will, at its option, refund the purchase price paid for the Product 
provided the Product has been returned to Kodak together with proof of the purchase price paid. Repair, replacement, or refund 
of the purchase price are the sole remedies under this warranty. If replacement parts are used in making repairs, those parts 
may be remanufactured or may contain remanufactured materials. If it is necessary to replace the entire Product, it may be 
replaced with a remanufactured Product. Remanufactured Products, parts and materials are warranted for the remaining 
warranty term of the original Product, or 90 days after the date of repair or replacement, whichever is longer.

Limitations
This warranty does not cover circumstances beyond Kodak’s control. This warranty does not apply when failure is due to 
shipping damage, accident, alteration, modification, unauthorized service, misuse, abuse, use with incompatible accessories or 
attachments (such as third party ink or ink tanks), failure to follow Kodak’s operation, maintenance or repacking instructions, 
failure to use items supplied by Kodak (such as adapters and cables), or claims made after the duration of this warranty. 
KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED 
WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. In the event that 
the exclusion of any implied warranty is ineffective under the law, the duration of the implied warranty will be one year from the 
purchase date or such longer period as required by law. The option of repair, replacement, or refund is Kodak’s only obligation. 
Kodak will not be responsible for any special, consequential or incidental damages resulting from the sale, purchase, or use of 
this product regardless of the cause. Liability for any special consequential or incidental damages (including but not limited to 
loss of revenue or profit, downtime costs, loss of the use of the equipment, cost of substitute equipment, facilities or services or 
claims of your customers for such damages resulting from the purchase, use or failure of the Product), regardless of cause, or 
for breach of any written or implied warranty is expressly disclaimed.

Your Rights
Some states or jurisdictions do not allow exclusion or limitation of incidental or consequential damages, so the above limitation 
or exclusion may not apply to you. Some states or jurisdictions do not allow limitations on how long an implied warranty lasts, 
so the above limitation may not apply to you. This warranty gives you specific rights, and you may have other rights which vary 
from state to state or by jurisdiction. Your statutory rights are not affected.

Outside the United States and Canada
In countries other than the United States and Canada, the terms and conditions of this warranty may be different. Unless a 
specific Kodak warranty is communicated to the purchaser in writing by a Kodak company, no warranty or liability exists 
beyond any minimum requirements imposed by law, even though defect, damage, or loss may be by negligence or other act.
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KODAK ESP 3200 Series All-in-One Printer
Declaration of Conformity

Declares our sole responsibility that the product

conforms to the following Product Specifications:

The product herewith complies with the requirements of the Low Voltage Directive 2006/95/EC, the EMC
Directive 2004/108/EC and carries the CE marking. In addition, it complies with the WEEE Directive 2002/96/EC and RoHS 
Directive 2002/95/EC.

The product was tested in a typical configuration.

Manufacturer's Name: Eastman Kodak Company

Manufacturer's Address: 16275 Technology Drive

San Diego, CA  92127, USA

Product Name: KODAK ESP 3250 All-in-One Printer

Power adapters: HP-A0601R3, VP-09500084-000

Radio Module Number: US101

Safety: IEC 60950-1:2001
EN 60950-1:2001 + A11:2004
UL 60950-1:2003 R7.06
CAN/CSA-C22.2 No. 60950-1-03

EMC: EN 55022:2006+A1:2007, Class B
CISPR 22:1997 Class B
EN 61000-3-2:2006, Class A
EN 61000-3-3:1995+A1:2001 +A2:2005
AS/NZS CISPR 22:2006, Class B
EN 61000-4-2:1995 + A1:1998 + A2:2001
EN 61000-4-3:2006 + A1:2008
EN 61000-4-4:2004
EN 61000-4-11:2004
EN 61000-4-8:2001 ED 1.1
CFR 47, FCC Part 15, Subpart B, Class B
EN 61000-4-5:2006
EN 61000-4-6:2007
ICES–003:2004 Class B
ANSI C63.4-2003

Radio: EN 301 489-1 V1.8.1 (2008-04)
EN 301 489-17 V1.3.2 (2008-04)
AS/NZS 4268:2003 + A1:2005 + A2:2006
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Index

B
Back button, 2
Black print speed, 38

C
Cancel button, 2
Changing ink cartridges. See Replacing ink 

cartridges
Cleaning the printer, 24
Components, printer, 1
Configuring your printer, 4

basic printer settings, 4
setting printer as the default printer, 5

Control panel, 1, 2
Copies

adjusting settings, 20
changing document options, 17
changing photo options, 19
darkening or lightening, 21
enlarging or reducing a photo, 20
enlarging or reducing documents, 20
making, 17

Copy document features, 39
Copy photo features, 39

D
Darkening copies, 21
Date and time

setting, 4
synchronizing to your computer, 4

Default printer settings, resetting, 4
Document paper sizes, 43
Downloading latest software and firmware, 36
DPOF. See Tagged images printing

E
Energy Star qualification, 46
Enlarging or reducing a copy

document, 20
photo, 20

Envelopes
capacity, 11
loading, 11
sizes, 9

Extender, paper tray, 1

F
FAQs, Web support, 36
Firmware, downloading, 36

G
Glass, scanner, 1
Greeting card size paper, 43
Guides

left paper-edge, 1
right paper-edge, 1

H
Home button, 2
Home Center Software, 3

for MACINTOSH Computers, 3
Maintenance pane, 3
Select pane, 3
Tools pane, 3

for WINDOWS OS-based computers, 3
Help icon, 3
Home icon, 3
Tools icon, 3

I
Image Capture software, 16
Image formats supported, 40
Index card stock sizes, 43
Ink cartridge

replacing, 27
Ink levels, 27
iPhoto software, 16
Iron-on transfers, 43

K
KODAK Home Center Software. See Home 

Center Software

L
Label sizes, 43
Language, setting, 4
LCD, 1, 2
Left paper-edge guide, 1
Lid, scanner, 1
Lightening copies, 21
Lights

power status, 37
Loading paper

envelopes, 11
photo, 10
plain, 9
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KODAK ESP 3200 Series All-in-One printer
M
Maintenance, 24
Marked images, printing. See Tagged images
Media supported, 42
Memory card slot, 1
Memory cards

printing pictures from, 13
types compatible with printer, 13

Monitoring printer performance, 35

N
Navigation buttons, 2

O
OK button, 2
On/Off button, 2
Overview of printer, 1

P
Panoramic photos, printing, 16
Paper, 8

loading
envelopes, 11
photo paper, 10
plain paper, 9

sizes, 8
sizes supported, 43
types, 8
types supported, 42

Paper stop, 1
Paper tray, 1
Paper tray capacity

envelopes, 11
photo paper, 10
plain paper, 9

Paper tray extender, 1
Photo paper

capacity, 10
loading, 10

Photo paper sizes, 43
Photo printing features, 38
Plain paper

capacity, 9
loading, 9

Ports
power cord connection, 1
USB, 1

Power status light, 37
Print photos options, 12
Print sizes, 38
Printer access door, 1
Printer performance, monitoring and 

adjusting, 35

Printer supplies
maintaining, 24
recycling, 24

Printhead
removing, 31
replacing, 30

Printhead with ink cartridges installed, 1
Printing

panoramic photos, 16
tagged image photos, 15

Protecting the printer, 24

R
Rear-access cleanout area, 1
Recycling printer or supplies, 24
Reducing or enlarging a copy

document, 20
photo, 20

Removing the printhead, 31
Replacing ink cartridges, 27
Right paper-edge guide, 1

S
Scanner

glass, 1
lid, 1

Scanning, 22
changing settings in Home Center 

Software, 22
multiple pictures simultaneously, 23

Service agreements, 24
Settings

basic printer, 4
Software support, 40
Software, downloading, 36
Start button, 2
Step-by-step solutions and repair, 36
Stop, paper, 1
System requirements, 36

T
Tagged images

printing, 15
setting, 4

Time to low power, setting, 4
Transferring pictures to a computer, 16
Transparency sizes, 43
Tray capacity

envelopes, 11
photo paper, 10
plain paper, 9

Tray, paper, 1
Troubleshooting, 36
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Index
U
USB port, 1

W
Warranty, 40
Water exposure, troubleshooting, 24
Web support

www.kodak.com/go/esp3250downloads, 36
www.kodak.com/go/esp3250specs, 36
www.kodak.com/go/esp3250support, 36
www.kodak.com/go/inkjetnetworking, 36
www.kodak.com/go/itg, 36
www.kodak.com/go/recycle, 24
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